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Word 2016 Complete Guide (Part 3): Get familiar
with basic text manipulation

If you are new to Microsoft Word, you will need to learn more about the basics of how to enter, edit and
organize text. Basic operations include adding, deleting and moving text on your documents, and how to cut,
copy and paste text.
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If you are new to Microsoft Word, you will need to learn more about the basics of how to enter, edit and
organize text. Basic operations include adding, deleting and moving text on your documents, and how to cut,
copy and paste text.

Readers can refer to the basic operations when working with Word documents in the video below:

In addition, you can refer to the Complete Guide of Word 2016 (Part 1 and 2) here:

1. Complete guide Word 2016 (Part 1): Familiarize yourself with the Ribbon interface
2. Complete guide Word 2016 (Part 2): Get familiar with OneDrive, create, save and share documents

1. Using insertion pointsto add text

Insertion point is a flashing vertical line in your document. It displays the location you can enter text on the
document page. Y ou can use insertion pointsin many different ways.

- Blank document : When opening a blank document, the insertion point will appear in the top left corner of the
page. If you want, you can enter text from this location.
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- Distance between wor ds : Press Spacebar to add distance after words or between paragraphs.
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- Next line down : Press Enter to move the insertion point to the next line.
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- Edit specific location : After the import is complete, you can use the mouse to move the insertion point to a

specific location in the document. Simply click on the location in the text - the position where you want to place
the insertion point to edit.
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- Arrow keys: Also you can use arrow keys to move insertion points. The left and right arrows move between
adjacent characters on the same line, while the up and down arrows move the paragraphs.

In ablank document you can double-click to move the insertion point to another location on the page.

2. Select text

Before formatting or moving text, you will have to select that text. To do this, click on the text you want to
select, then release the mouse button. The selected text will be blacked out.



B H:0Bignature wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

- When selecting text or image in Word, a Toolbar containing the shortcut keys will appear. If the Toolbar does
not appear, try hovering over the selected item.
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B H:0j5ignature Wash
Cars 520 - SUVs 525 and up
Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

3. Select multiplelinesin thetext

1. Movethe insertion point to the left of any line.

- H;0 Signature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

Bl signature Interior
Cars 540 - SUVs 560 and up - March special! S5 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

2. Click and the text will be selected.

B 1.0 signature Wash
Cars 520 - SUVs 525 and up

4 Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

Bl signature Interior
Cars $40 - SUVs S60 and up - March special! S5 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

3. To select multiple lines, click drag the mouse up or down.



- H,O Signature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

[l signature Interior

Cars 540 - SUVs S60 and up - March special! 55 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
4 and cup holders.

4. To select all documents in the document, select the Select command in the Home tab , then click Select All .
Or dternatively, press Ctrl + A.
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- Other shortcuts include double-clicking to select 1 word or 3-click to select the entire sentence or paragraph.

4. Delete text

Here are some ways to delete text:
- To delete the text to the left of the insertion point, press the Backspace key on the keyboard.
- To delete the text to the right of the insertion point, press the Delete key.

- Select the text you want to delete, then press Delete .
5. Copy and move the text

Word alows users to copy text in documents and paste into another location. If you want to move the text to
other locations in the document, you can cut and paste or drag and drop.

- Copy and paste text:

1. Select the text you want to copy.



- HZOISignature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

- Signature Interior

Cars 540 - SUVs 560 and up - March special! 55 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

2. Click the Copy command on the Hometab . Alternatively, you can press Ctrl + C.
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3. Move the insertion point to the location where you want to paste the text.

- H,0 Signature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

Bisignature Interior

Cars 540 - SUVs 560 and up - March special! 55 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

4. Click the Paste command on the Home tab . Alternatively, you can press Ctrl + V.
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5. Text will appear at the location where you paste.



- H;0 Signature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

- H,Ofignature Interior

Cars 540 - SUVs 560 and up - March special! 55 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

- Cut and pastetext:

1. Select the text you want to cut.

B HZOISignature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

B signature Interior

Cars 540 - SUVs 560 and up - March special! S5 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

2. Click the Cut command on the Hometab . Or alternatively, press Ctrl + X.
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3. Move the insertion point to the position where you want to paste the cut text.

- H,0O Signature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

I
h H.0 Signature Interior
Cars 540 - SUVs 560 and up - March special! 55 off
Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

lLeather Cleaning & Conditioning
Cars 520 - SUVs 540 and up - March special! 55 off
Includes seats and door panels.



4. Click the Paste command on the Hometab . Alternatively, you can press Ctr| + V.
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5. The text that you paste will appear in the location where you paste it on the document.

- H,0 Signature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

- H,0 Signature Detail
Cars 560 - SUVs 575 and up - March special! 510 off
Everything included in the Signature Wash, plus hand wax and buff. |

B H.0 Signature Interior

Cars 540 - SUVs 560 and up - March special! 55 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

- Drag and drop text:

1. Select the text you want to move.

B Paint Correction & Protection
Call for pricing - March special! 10% off

Prices may vary depending on size of vehicle. Heavily soiled vehicles are subject to an additional charge. ]
Schedule your appointment today!

Contact Hank Odum at 321-555-5400 or hank@H20mobile.com

Special rates available for weekly/monthly customers

H;0 Mobile Wash & Valet | Just leave the details to us

2. Click and drag the text to the position you want to paste. A small rectangle icon will appear below the arrow
S0 users can know that the text is being moved.



B Paint Correction & Protection
Call for pricing - March special! 10% off

Prices may vary depending on size of vehicle. Heavily soiled vehicles are subject to an additional charge.
Schedule your appointment today!
Contact Hank Odum at 321-555-5400 or hank@H20mobile.com

Special rates available for weekly/monthly customers

H;0 Mobile Wash & Valet | Just leave the details to us
'y,

3. Release the mouse button and the text will appear where you pasted.

B Paint Correction & Protection
Call for pricing - March speciall 10% off

Schedule your appointment today!
Contact Hank Odum at 321-555-5400 or hank@H20mobile.com

Special rates available for weekly/monthly customers

H;0 Mobile Wash & Valet | Just leave the details to us

I/\\f-"rfces may vary depending on size of vehicle. Heavily soiled vehicles are subject to an additional charge.

If the text does not appear at the exact location you want to insert, then you can press Enter to move thetext to a
new line.

6. Undo and Redo

Suppose you are working on a document and you accidentally delete the text. Fortunately, there's no need to re-
enter the text you just accidentally deleted. Word allows users to undo most recent actions.

To do this, find and select the Undo command on the Quick Access Toolbar . Alternatively, you can press Ctr |
+ Z. You can continue to use this command for multiple changesin arow.
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In contrast, the Redo command alows you to redo Undo operations. Alternatively, you can access the Redo
command by pressing Ctrl + Y.
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7. Symbol

If you want to insert characters that are not on the keyboard, such as the copyright (©) or trademark (™) symboal,

then you can add these symbols with the Symbol command.
Toinsert anicon:
1. Move the insertion point to the position you want to add the symbol.

Schedule your appointment today!
Contact Hank Odum at 321-555-5400 or hank@H20mobile.com

Special rates available for weekly/monthly customers

H,0 Mobile Wash & Valet | Just leave the details to us|]

Prices may vary depending on size of vehicle. Heavily soiled vehicles are subject to an additional charge.

2. Click the Insert tab .
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3. Navigate and select the Symbol command, then select any icon you want from the drop-down menu. If you

cannot find the icon you want to add, select More Symbols.
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4. The icon you want to add will appear on the document.

Schedule your appointment today!
Contact Hank Odum at 321-555-5400 or hank@H20mobile.com
Special rates available for weekly/monthly customers

H,0 Mobile Wash & Valet | Just leave the details to us”‘“I

Prices may vary depending on size of vehicle. Heavily soiled vehicles are subject to an additional charge.

Refer to some of the following articles:

1. How to check the version of Microsoft Office you are using is 32-bit or 64-bit
1. Fix the error "The document is locked for editing by another user” when opening a Word document
1. Download and install or reinstall Office 365, Office 2016, Office 2013 on your computer

Good luck!

Y ou finished reading the article "Word 2016 Complete Guide (Part 3): Get familiar with basic text
manipulation” edited by the TipsM ake team. We hope this article has provided you with many useful tech tips
and tricks. Y ou can search for similar articles on tips and guides. Thank you for reading and for following us

regularly.
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